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Electronic Data Capturing 

A Training Manual 

Tamirat Bejiga, Email: tamiratbejiga@gmail.com; Phone: +251 927259470  

Amare Seyoum, Email: seyoumamare99@gmail.com; Phone: +251 913950590  

 

1. Introduction 

 

lectronic data capture and management is fundamental to modern day 

plant breeding and other research areas focused on data (processing 

system) specially data collection as it allows an increased scale and efficiency, 

reduced error and better use of information. 

 

Problems in our current using electronic data collection are turnover of trained 

researcher, electronic data capture gadgets (tablets) in hand of individual or not 

used in team, merging problem due to not well-prepared data sheet (filed book) 

format, missing Kombine path (missed up of Kombine configuration), 

debugging related issues of the android enabled devices, etc. Data scoring 

problems due to not checking after merging, not merging regularly after 

collecting data, missing use of validation rule, etc. 

 

Fieldscorer – an android-based mobile program should install into tablets or 

mobiles that run android OS enables electronic data capture. A CSV (Comma 

Separated Value) data sheet (Filed book) prepared in computer is imported into 

the android device or merged using a software program Kombine. Scored data 

should later merged back to the computer by using Kombine program and 

synchronize into the computer.   

E 

Challenges in data collection in hard copies and handling are time taking 

and inefficient, highly prone to hand writing errors, takes time to type into 

computers with high potential unreadable and confusing hand-written data, 

delays reporting, difficult to get data from collaborating centres, etc 

mailto:seyoumamare99@gmail.com
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Filedscorere4Android is an application for collecting trait data in fields using 

a device running an Android operating system and the version of the OS should 

be higher than 2.2. This manual is prepared to give intention to use it under 

different circumstances. Fieldscorer is highly customizable to use as our need 

and the objective of the data we need to collect. The only thing we should 

remind to use it is the data sheet or the filed book that we merge or import to 

Fieldscorer should have a valid format as per mentioned in the manual for filed 

book preparation.  As far as research institutions, Universities, Training centres 

(such as FTCs), NGOs focused on researchable areas and data collection, 

organizations having surveying issues and others can use it. 

2. Fieldscorer Installation 

Minimum Requirements 

Android 2.2 

Device screen size 3.7 inches or larger (may work on smaller screens) 

The APK file 

To install Fieldscorer4Android, either download the APK file using the device, 

or download it from another device and copy it to the android device.   

Installing Fieldscorer on a device also can be by using Kombine 

(Recommended). 

Once the APK file is on the device open the APK file using a file manager 

application. If a file manager is not on your device, there are plenty of free 

ones available. You will need to ensure that the "Unknown Sources" option 

must be checked in the devices security settings to install the software, which 

are out of the manufacturer permission set to the device. This option can be 

disabled once the application is installed.  

 

The following instructions are based on the Lenovo tablet, but should be 

similar for most modern android devices.  

Turn on Unknown sources (Required to install .apk files) 

Select Settings 

http://www.katmandoo.org/Help/Fieldscorer4Android/downloads.html
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Turn on Unknown sources 

Select Security 

 

Turn on Unknown sources 

 

USB Debugging Mode 

Return to settings 
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Select About tablet 

 

NB. Only do this if Developer options is not visible 

USB Debugging Mode 

Press Build number 7 times 

 

USB Debugging Mode 

Return to settings 
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Select Developer options 

 

USB Debugging Mode 

Enable USB debugging 
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2.1. Installing Fieldscorer using Kombine 

Using Kombine 

Must be version 2.0.5.0 or later 

Make sure device is accessible from PC and running the “adb” driver is 

running. 

Run Kombine 

Tools -> Install Fieldscorer 

 

 

2.2. Download the .apk file 

Return to settings  

Select WLAN 

Connect to WiFi 
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Download the .apk file 

Return to home screen 

Open Chrome browser 

Search “Fieldscorer” 

 

Download the .apk file 

Select the navigation button 

Select Downloads 
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Download the .apk file 

Download the latest version 

Press OK on the popup 

Download icon will appear 

NB. Android 6 & 7 devices may require installation of 2.14 prior to 2.16 to 

enable permissions during installation 
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Install the .apk file 

Return to home screen 

Open Downloads 

Select the Fieldscorer file 

Install the .apk file 

Select Next or scroll down 

Select Install 
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Install the .apk file 

Select Open 

 

Exit Fieldscorer 

Press back 

Select YES 
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NB. Fieldscorer must be opened once to create a blank database file for 

Kombine 

 

2.3. Manual Installation 

Requires a file browser (eg. Amaze from the google play store) 

Connect the tablet to a PC 

Copy the file to the device 

Open file browser on the tablet 

Find the apk file 

Click the apk file to install 

Creating a shortcut 

Press the Apps Button 

Creating a shortcut 

Press the Apps Button 

Press and hold Icon 
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Creating a shortcut 

Press the Apps Button 

Press and hold Icon 

Place the icon 

 

Cleaning up 

Press the Overview Button 

Close Apps using broom icon 
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Once installed the Fieldscorer Application Icon will appear under Apps. 

Screen layouts 

Fieldscorer 4 Android has support for most screen layouts. Functionality is the 

same between layouts, but the position of controls varies, to ensure that the 

soft input keyboard can still be used for various layouts. Due to the large 

number of screen sizes available for Android we cannot test layouts on all 

devices.   

A portrait and landscape layout are offered for various screen sizes. The 

layout will lock when Fieldscorer is opened. It is recommended that you lock 

the screen orientation of the device before using Fieldscorer. 

Portrait Layout 

The portrait layout is the default option for scoring on most devices. 
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Landscape Layout 

The landscape layout can be run by opening Fieldscorer with the device in 

the landscape mode 

 

Unit Position Buttons 

The Unit Position buttons allow quick jumping to plots within the current 

trial. 

Column and Row indicate positions within the trial grid. Pressing the button 

will bring up a list of all available column or row positions. Selecting one of 

these positions will jump to the corresponding row and column number in the 

trial. 
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The Replicate button allows a user to jump quickly to a different replicate plot 

of the current genotype. The Replicate button is only visible if a replicate 

column exists in the current trial. 

The barcode control can be used to jump to a different plot by either entering 

a plot barcode or scanning using the devices built in camera or a connected 

barcode scanner. This option can be enabled under the Barcode Options Menu  

 

Genotype and Pedigree Display 

The Genotype and Pedigree display shows the Genotype and Pedigree for the 

current plot. If the detail is to long then the text can be scrolled. A long press 

of the text will bring up a window with the full name. 

 

Trait Scoring 

Depending on the trait settings, the display for trait input can be quite 

different. 

Boolean traits have two checkboxes for True and False with an empty score 

for either true or false. 

The default trait box has a single text box, which will allow for any input. 

Days Calculation Traits have 2 boxes, an offset box and a score value box. 

The offset is used to calculate the difference between today and a particular 

date, such as the date sown, the first of January or the date of emergence. eg. 

if Scoring Days to Flower and the plant flowered yesterday, the user would 

enter -1 into the offset box. 

Comma separated validation traits display as a single textbox with the 

scoring buttons changing to fit. 

 

Trial Unit Comment 
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The trial unit comment (plot comment) is designed for generic comments 

about a plot. When selected, on most devices the selection of this box will 

bring up soft input keyboard on the device. NB. These comments will not be 

date stamped 

 

Scoring Buttons 

The scoring button panel default is 0-9, minus, period and NA. NB. NA is a 

standard scoring value for scoring a missing plot and is ignored by validation. 

Long pressing these buttons allows the ability to temporary change the input 

value. Restarting the application will reset the scoring buttons to the standard 

defaults. When scoring a trait with a comma separated validation the default 

scoring buttons will be replaced by the comma separated list. 

 

 

Next Plot Button 

This button will jump to the next plot in the walking path sequence order 

Tab Button 
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This button will jump to the next trait in order. If Auto-Progress Trial unit is 

selected, the tab button will jump to the next trait once after the final trait is 

reached 

 

Next Blank Button 

This button will jump to the next plot in sequence where the currently selected 

trait has no value. This feature is commonly used for traits that are scored over 

a period rather than all at once e.g. days to flower. 

 

Previous Plot Button 

This button will jump to the previous plot in the walking path sequence order 

Backspace Button 

The backspace button will remove text from the currently selected trait 

 

Camera Button 

Take a photo of the current plot to store as a Trial Unit Image, or view the Trial 

Unit Information dialog (with images) if a photo has been taken. 

Multiple photos of the same plot are given unique names with the file names 

being stored in a semi-colon separated list in the database. 

 

Comments Button 

The comments button opens up a dialog for viewing large comments, which 

can be used to quickly select previous comments from a unique list of all 

comments previously recorded for the current file. 

 

File Menu 

Import - Open import dialog to import a CSV trial file into the database. 

Save As - Export the current trial file with a different file name. 

Open - Open a trial file that has been imported into the database. 

Check for Updates - Check if an updated version of Fieldscorer exists. If a 

new version exists, a dialog will prompt user to download and install. 
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Help - Open this help documentation through a web browser. 

About - View version and licensing information. 

Exit - Close down the trial and exit the application. 

Trial 

Trial Unit Information - Display plot information including plot images. 

Export Trials - Bulk Export database trials to CSV overwriting the files with 

the same filename. 

Delete Trials - Remove a trial from the database. N.b. Please ensure you 

have exported your trial file or backed up your database before deleting trials. 

Search Trial - Search the trial using a single condition based on any column 

within the file 

Trial Progress Map - Display which plots have a particular trait scored 

using the trial grid. 

Preview Trial - Display a grid with all data from the current trial file as it 

will appear when exported to CSV. 

 

Traits 

Open the traits dialog to select traits for scoring  

Database 

Backup Database - Copy database file to another location 

Restore Database - Overwrite database with a backup version 

 

Options 

Walking Path  

Serpentine column by row  

Sort scoring sequence to go along the column and back the next 

Serpentine row by column  

Sort scoring sequence to go along the row and back the next 

Column by row  

Sort scoring sequence to go along columns 

http://www.katmandoo.org/Help/Fieldscorer4Android/traits.html#the-trait-dialog
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Row by column  

Sort scoring sequence to go along rows 

Original file order  

Use the original import file order to sort the scoring sequence 

Sort by column and row only  

Check this if scoring across multiple adjoined trials (or trial types) at once 

 

Progression  

Auto progress traits  

If Auto Progress Length is set for the trait, scoring of a trait will 

automatically select the next trait in sequence once the character length is 

reached. 

Auto progress trial unit  

Jump to the next plot after the last trait box in sequence. 

Notify end of column  

Play a sound whenever the column changes 

Notify end of row  

Play a sound whenever the row changes 

Use Vibration  

Vibrate device when notification sounds occur 

Skip Decimal Rows  

Forces sequence to only use column numbers. A sound is played when a 

skipped row is crossed. 

Skip Decimal Columns  

Forces sequence to only use column numbers. A sound is played when a 

skipped column is crossed. 

NB. Decimal plots are often used for spray lanes or when plants within plots 

are scored. 

 

Date Format  
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Use Sown column  

Calculate days traits using difference between sown date column and the 

current date with offset 

Use Ordinal Date  

Calculate days traits using difference between January 1 of the current year 

and the current with date offset 

Use Custom Column  

Calculate days traits using difference between user specified date column and 

the current date with offset 

DD/MM/YY, DD-MMM-YYYY, YYYY-MM-DD HH:MM: SS  

Date/Time stamp date format for traits that have date stamping enabled 

 

File Format  

Use Trial Name  

Use the trial details to label image files. 

Use File Name  

Use the file name to label image files. 

 

Barcodes  

The barcode menu allows quick jumping to a plot using a unique position 

code (plot barcode) 

Use Barcode  

Hide/show the barcode control on the main scoring screen. 

Text Box  

Enable barcode textbox for entering barcodes or using a connected barcode 

scanner. 

QG Code  

Use internal camera to scan a QR Code Barcode (Requires zXing Barcode 

Scanner).  

Code 39  

https://play.google.com/store/apps/details?id=com.google.zxing.client.android&hl=en
https://play.google.com/store/apps/details?id=com.google.zxing.client.android&hl=en
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Use internal camera to scan a Code 39 Barcode (Requires zXing Barcode 

Scanner).  

Code 128  

Use internal camera to scan a Code 128 Barcode (Requires zXing Barcode 

Scanner).  

EAN 13  

Use internal camera to scan a EAN Barcode (Requires zXing Barcode 

Scanner).  

Quick Jump  

Opens the quick jump dialog to enter a plot number to progress to. 

 

Column Mapping  

Set fields to be displayed below the genotype and pedigree display on the 

main scoring screen  

 

Additional Options  

Use dark backgrounds  

Set background to black for better visibility in the sun and improved battery 

life on some devices. 

Invert control colours  

Invert all control colours on the scoring screen 

Show soft input  

Always display soft input whenever a trait is manually focused (by touching 

it rather than auto progression or use of the tab button). N.b. Some devices 

require this setting checked to accept any input. 

Hide simple button layout  

Show/Hide additional next plot, previous plot and next blank buttons at the 

screen for use with soft input keyboard. 

Use text to speech  

Device will speak the current score value as it is entered. 

Voice recognition  

https://play.google.com/store/apps/details?id=com.google.zxing.client.android&hl=en
https://play.google.com/store/apps/details?id=com.google.zxing.client.android&hl=en
https://play.google.com/store/apps/details?id=com.google.zxing.client.android&hl=en
https://play.google.com/store/apps/details?id=com.google.zxing.client.android&hl=en
https://play.google.com/store/apps/details?id=com.google.zxing.client.android&hl=en
https://play.google.com/store/apps/details?id=com.google.zxing.client.android&hl=en
http://www.katmandoo.org/Help/Fieldscorer4Android/layout.html#genotype-display
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When a trait is selected activate voice recognition. N.b. Voice recognition in 

Fieldscorer requires internet connection. It can be slow and may cause invalid 

data scores. Please use caution if experimenting with the voice recognition 

feature. 

 

Use external camera App  

Use either the default external camera application or the camera dialog built 

into Fieldscorer for taking trait and plot images 

Web Proxy  

Set proxy address and port (if required) for use with the check For updates 

option  

 

 

3. Creating a Field book file 

 

Example MS2018SGEMN  

MS is the site 

2018 is the year 

SGEMN is the trial type code 

With a consistent naming convention files can be sorted and searched easier 

Currently Fieldscorer4Android imports and exports using a 

comma-separated file format (.CSV). Data is stored in a SQLite 

database file format, which can be access and modified using 

and external editor if necessary. File naming include 

information about the trial into the filename. In this case, few 

columns are mandatory (should be included in the filed book) 

to run Filedscorer4Android correctly. Such as, Row, Column, 

Block (Replication). 

http://www.katmandoo.org/Help/Fieldscorer4Android/menu.html#check-for-updates
http://www.katmandoo.org/Help/Fieldscorer4Android/menu.html#check-for-updates
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Underscores and dashes can be used as separators in file names 

When a backup or copy is made add a date to the filename 

Spreadsheet layout 

CSV is comma delimited use in Fieldscorer plain text using comma as a 

delimiter, faster load times and what you put in is what you get out than using 

XLS/XLSX (Excel workbook) which may consist multiple Sheets and contain 

fonts, colours, formulas, macros etc. 

 

All image files are stored in the JPEG file format. Quality is dependent upon 

the camera built into the device.  

Trial Files 

Fieldscorer uses a flat file format so there needs to be unique values in each 

row of the combined SiteYear, SiteName, TrialType Name, TrialNumber, 

Column and Row. These columns are not all required, though they are used to 

differentiate multiple trials within a single csv file. 

Column naming 

Aim for consistent column and trait names 

Yield is not the same as YLD or Yield (kg/ha) 

Trial_no is not the same as TrialNo or Trial# or Trial Number 

Field book template 

Contains all of the columns you might need, consistent between trials and 

makes it easier to stack data (join trials into one file) 

Fieldscorer hard coded columns used by the system are:  

Site Year (or Year) 

SiteName (or Site) 

Trial TypeName (or TrialType or Type) 

Trial Number (or Trialno) 

Column (or Col or Range) 

Row 

Sown (or Planted, or DateSown, or DatePlanted, or Planting or SownDate, or 

Trial Start Date) 



 

 

24 

 

Trial Unit Comment (or Comment, or Comments, or PlotComment) 

Genotype Name (or Genotype, or cultivar, or variety, or entry number, or 

entry#) 

GenotypeId (or GID) 

Pedigree 

Replicate Number (or Replicate, or Rep) 

Trial Unit Barcode (or Plot Barcode or Sample Entry Number, or Plot 

Number, or Plot or PlotNo, or Plot#,) 

N.b. Columns in bold are required for import. 

 

Genotype Names 

Enforce consistency within a sheet and watch out for spelling mistakes and 

local names. Spaces matter example GEN106 is not the same as GEN 106 to 

a computer and 1 Space does not equal 2 spaces ie. GEN 106 vs GEN  106 

 

Spatial columns  

provides capacity to sort using various walk path options, useful for describing 

planting layout, ensure that planting layout is retained in data file and terms 

Column and Row can be reversed, but try to be consistent within your group 

and required for future spatial analysis 
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An Example of a Trial File: 

 

 

4. Creating a Traits file 

Trait fie must be named Traits.csv, uses hard coded column names, used to 

lookup additional information for field book column headers 

 

Trait Name: The name of the trait that will appear on the scoring screen 

Examples: DTF, LDG, PH, Height, etc. Often abbreviated to save space on the 

screen in Fieldscorer and so that it can easily be seen in a spreadsheet. Ensure 

that the name matches up with column headers and to create repeated measures 

of a trait the trait column header in the field book file can use a double 

underscore to separate the instances. 

Year Site Type Plot Column Row Replicate PlotBarcodGenotype Pedigree Female Male Check Old_genotpeSown

2018 Mieso MS17 Early Maturing National Sorghum 1 1 1 1 *MS18 Early Maturing National Sorghum-1-1*Pipeline 2(Teshale/E-36-1)BC3F3Teshale/E-36-1BC3F3

2018 Mieso MS17 Early Maturing National Sorghum 2 1 2 1 *MS18 Early Maturing National Sorghum-1-2*14MWLSDT7191WSV387/E-36-1WSV387 E-36-1

2018 Mieso MS17 Early Maturing National Sorghum 3 1 3 1 *MS18 Early Maturing National Sorghum-1-3*2401 (S35/B35)/S35S35/B35 S35

2018 Mieso MS17 Early Maturing National Sorghum 4 1 4 1 *MS18 Early Maturing National Sorghum-1-4*Melkam WSV 387 WSV 387

2018 Mieso MS17 Early Maturing National Sorghum 5 1 5 1 *MS18 Early Maturing National Sorghum-1-5*14MWLSDT7325SDSL2690-2/76T1#23SDSL2690-276T1#23

2018 Mieso MS17 Early Maturing National Sorghum 6 1 6 1 *MS18 Early Maturing National Sorghum-1-6*12MW6243WSV 387/76T1#23WSV 387 76T1#23

Column 1 Row 1 

Column 5 Row 5 
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i. e. A Trait Name of Plant Height (PHT) will work for columns PHT__1, 

PHT__2 and PHT__5 

 

TraitValRule: Trait validation rule which is used to enforce data integrity, the 

value “NA” is always valid, numeric datatypes use two full stops to define 

range example: 1.9, String validation uses comma separated validation 

example: Red,Green,Blue and cannot combine two methods eg 1..9,18,25 X 

 

DataType: The data type of the trait. 

Integer – Whole number values. Eg. 1, -1, 1024 

Decimal – Decimal numbers (whole numbers also accepted). Eg. 1.35, 0.6 

String – any set combination of characters.  Used for words and sentences. Eg. 

Red, Blue, A Trait Value, Tex, VC5 

Boolean – TRUE and FALSE values 

Photo – take a picture which embeds the trait name 

Date – Select a date 

DateTime – select a date with the current time 

Angle – Decimal angle of the device.  NB. Move device slowly to get more 

accurate readings. 

GPS – Latitude and longitude values of current position 

Trait Name: The name of the trait that will appear on the 

scoring screen Examples: DTF, LDG, PH, Height, etc. Often 

abbreviated to save space on the screen in Fieldscorer and so 

that it can easily be seen in a spreadsheet. Ensure that the name 

matches up with column headers and to create repeated 

measures of a trait the trait column header in the field book file 

can use a double underscore to separate the instances. 
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Auto Progress Field Length: The number of characters required before the 

auto progression to next trait/trial unit will trigger. If left blank then auto 

progression of this trait will be disabled.  If using barcode heights leave the 

Auto Progress Field Length value blank as the barcode scanner will progress 

automatically after a scan. Best suited for single button press trait scores. 

Examples 1-9, Red, Green, Blue, TRUE & FALSE 

 

IsDaysTrait: Determines whether day offset calculations are used to process 

this trait. If TRUE then the value scored will be a calculated value of the 

number of days between today and planting date (or the alternative specified) 

added to the offset entered by the user. Choose FALSE for all other traits 

DateStamp: Determines whether a generated Date Stamp column will be used 

for the trait. If TRUE then a column with the prefix “Date_” will be used to 

hold the time stamp of the trait score. Scoring HGT will put the current date & 

time into Date_HGT. FALSE will not save the date value when scoring 

 

TraitUnits: The units that define the trait. Eg. cm, days, kg, etc. This field can 

also be used to provide a description about the trait as it is displayed below the 

trait name on the trait selection screen. Eg. Common Leaf Rust Severity Rating 

(1= clean, no infection) to (5= severely diseased) 

Connection: Used to hold the pipe separated list of values required to connect 

to a digital device. Currently only works with devices connected using 

Bluetooth wireless technology. Includes MAC address of connection and 

polling and stable string information. Example Traits.csv file  

 

 

TraitName TraitValRuleDataType AutoProgressFieldLengthIsDaysTraitDateStamp TraitUnits Connection

DTE 3..15 I TRUE TRUE Days to 50% emergence from date of sowing (under wet sowing) or date of effective rainfall after dry sowing

Vigour 1..5 I FALSE TRUE Score (1-5)

DTF 30..150 I TRUE TRUE Days to 50% flowering (number of days from date of 50% emergence date of the field to date of 50% flowering)

PHT1 30..600 D FALSE TRUE cm (Plant Height)

InsectScore 1..5 I FALSE TRUE Over-all insect resistance score (1-5 scale; 1=no damage, 2=1-10% of plants damaged, 3=11-25% of plants damaged, 4=26-40% of plants damaged, 5=more than 40% of plants damaged)

DiseaseScore 1..5 I FALSE TRUE Over-all disease resistance score (1-5 scale; 1=no damage, 2=1-10% of plants damaged, 3=11-25% of plants damaged, 4=26-40% of plants damaged, 5=more than 40% of plants damaged)

DroughtScore 1..5 I FALSE TRUE Tolerance to soil moisture deficit score (1-5) where 1= more tolerant

RootLodging 1..5 I FALSE TRUE Score (1-5)

StemLodging 1..5 I FALSE TRUE Score (1-5)

BirdDamage S FALSE TRUE % bird damage

DTM I TRUE TRUE Days to maturity (number of days from date of 50% emergence of the field to date of physiological maturity)

RawWeight D FALSE TRUE g (Raw head weight)

Yield/Plot D FALSE TRUE g (Grain yield per plot)

YieldKg/Ha D FALSE TRUE Kg (Grain yield per hectar)

PAS 1..5 I FALSE TRUE Over-all plant aspect/agronomic desirability Score (1-5 [1=very good, 2=good, 3=average, 4=below average, 5=poor)

1000GW D FALSE TRUE 1000 kernel weight (weight of 1000 kernels/seeds in grams at moisture content equal to or less than 12%)
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5. Kombine 

Importing Files 

To add data to trial files, the file must be imported into the database. To import 

a trial file, open the File menu and select Import. The import dialog will open 

appear and files can be selected to open. Multiple files can be imported at once 

by selecting more than one before pressing the import button.  

N.B. Importing files could take several minutes depending on the size and 

number of files and the speed of the device therefore using combine is better. 

Kombine synchronises data/files from multiple devices to a single csv file on 

a PC or server share Copy the Kombine installer  

Double click Kombine-2.0.5.msi 

 

Follow the prompts 

Requires Administrator Privileges 

 

Installing the Samsung driver (Samsung users) 

Copy the driver installer  

Right click the file: SAMSUNG_USB_Driver_for_Mobile_Phones.exe 

Select Run as administrator 

Follow the prompts to install the driver 
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Installing the Lenovo driver (Lenovo users) 

Copy the driver  

Ensure that the Lenovo device is not connected to the computer 

Right click the file: LenovoUsbDriver_autorun_1.1.16_user.exe 

Select Run as administrator 
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Installing the Lenovo Tablet driver 

Click the start button and type device manager into the search box 

Click Device Manager 

  

Installing the Lenovo Tablet driver 

Connect the Lenovo tablet and allow windows some time to detect the device 

An unknown device called MT65xx Android Phone may be visible in the list 

of devices 

Right click the MT65xx device and Select Update Driver Software… 
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 Installing the Lenovo Tablet driver 

Select Browse my computer for driver software 

 

Installing the Lenovo Tablet driver 

Select Let me pick from a list of device drivers on my computer 

 

Installing the Lenovo Tablet driver 
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Select Show All Devices 

Click Next 

 

 

Installing the Lenovo Tablet driver 

Select Have Disk 

 

Installing the Lenovo Tablet driver 

Select Browse to locate the driver file 
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Installing the Lenovo Tablet driver 

Located the Lenovo_adb file in 

 C:\Program Files (x86) \LenovoUsbDriver\ADB or  

 C:\Program Files\LenovoUsbDriver\ADB 

Select Open 

C:\Program Files (x86)\LenovoUsbDriver\ 

 

Installing the Lenovo Tablet driver 

Select Okay to confirm the file location 

 



 

 

34 

 

Installing the Lenovo Tablet driver 

Select Lenovo Composite ADB Interface 

Select Next 

 

 

Installing the Lenovo Tablet driver 

 

Installing the Lenovo Tablet driver 

Close the window 

 

Installing the Lenovo Tablet driver 

The driver should now be updated in device manager 
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5.1. Merging files 

Synchronization issues and procedures 

Open Kombine 

 

Synchronisation Setup 

Select the settings tab 

 

Synchronisation Setup 

The other way to bring files from computers into the database and store 

back scored data into the files in the computer is via the program 

Kombine. As far as Kombine works properly which is the case in most 

situation, merging using the program should be followed. Merge settings 

are as follows 
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Backup path (shared location) 

 

Synchronisation Setup 

Backup path (shared location) 

Creates a folder for each day that a merge occurred 

Holds lock file and logs 

 

Synchronisation Setup 

Backup path (shared location) 

Creates a folder for each day that a merge occurred 

Holds lock file and logs 

Daily folder contains compressed database backups and csv files where 

changes have occurred 
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Synchronisation Setup 

Folder pairs 

FSDB.sqlite file is the database file on the device 

 

Synchronisation Setup 

Folder pairs 

Shared folder 
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Synchronisation Setup 

Android path 

For exports and images (retains file structure) 

 

Merging Data 

Select Run Merge 

 

Merging Data (process) 

Downloads database and new images 

Creates a compressed backup file 

Merges Traits and Genotypes files 

Iterates through folders 
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Checks for changes and master/deleted files 

If changes exist then merge files together 

Both files get data using keys 

If duplicate data exists then new version is used 

 

Common errors 

 

Device Authorisation 

Check tablet for Allow USB debugging prompt 

Select always allow from this computer 

Device not found 

Ensure that tablet is connected 

Ensure ADB drivers installed 

Ensure USB Debugging mode is enabled on the tablet 

Primary Keys do not match 

Ensure that file keys (column, row etc) match that in the file 

Set master file if keys have changed 

Failed to load file 

Ensure that the csv file is closed and try again 

Checking lock file repeats and reports lock files 

Confirm that no one else is running a merge 

Lock can be removed from Merge button -> Remove Merge Lock 
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Master Files 

Required if design changes 

Forces connected device to use the shared version 

Creates a backup before overwriting 

Retains a log of who has been updated 

To set a master file 

File -> Set Master File 

Select master file 

Select file to replace 

 

 

Deleted Files 

Used to remove a file from the devices 

If deleted through the file manager it will be retained in the database 

File will be backed up before deletion 

To mark a file for Deletion 

Select File->Delete File 

Choose file to be deleted 
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Opening Files 

Once a trial file has been added to the database it can be opened by selecting 

the Open option from the file menu. There may be a short delay while the walk 

path sequence is generated. Opening a trial should jumpt to the first plot in the 

trial as determined by the walk path sequence. 

Scoring traits using Fieldscorer 
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 Open a trial using the 

  folder icon 

 

Select Training.csv 

 

Select the traits button 
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Check Yield 

Press back to return to the scoring screen 

 

Select the Menu button 

Select Options 

Select Walking Path 
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Select Serpentine Column by Row 

This means you are walking along the column in a zig zag fashion 

Press back to return 

Tap outside of the menu to return 
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Serpentine Column by Row 

 

Press the next plot button to advance to the next row 

 

 

 

Press options button 

Select Progression Options 
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Press options button 

Select Progression Options 

 

Press previous plot button to go back one plot 

Press and hold to go to beginning 
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Select the Menu button 

Select Options 

Select Walking Path 

 

 

 

 

 

Select Serpentine Row by Column                                                  

This means you are walking along the row in a zig zag fashion 

Press back to return 

Tap outside of the menu to return 
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Serpentine Row by Column 

 

Press the next plot button to advance to the next column 
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Press the Column button 

Select Column 5 

 

Jumps to Column 5 Row 2 

Press the replicate button 
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Select Replicate 2 
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Press and hold to go to the first plot 

Experiment with other walking path layouts 

NB. Original file order will use the sort order of your original CSV file 

 

 

Row by Column 
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Column by Row  

 

Select the trait icon 

 

Select Notify End of Row 

Press back to return to the scoring screen 
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At column 3 row 4 an invalid data entered message will appear 

Select Keep Value 

NB. If the value is invalid select Edit Value option and it will be highlighted 

for overwriting 

 

Select the trait icon 
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Highlight the Row by selecting the trait name 

Select the Edit Icon 

NB. On smaller screens the menu in the top right will be required to select 

the edit option 

 

Increase the range to 120 

Ie. 70..120 

Select Save to update  the trait 

NB. The device keyboard usually has an option in the bottom left to change 

between alpha and numeric characters 
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Note that the validation rule has now changed 

Press the back button or the tick to return to the trait scoring screen 

Continue scoring and note that values greater than 118 are now accepted 

 

Select progression options 

Select auto progress traits 
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Return to the first plot 

Select DTF for scoring 

Score flowering visit 1 

Monday is -2 (2 days ago) 

Tuesday is -1 (1 day ago) 

Wednesday is 0 (for today) 

 

The NA button is used to represent a missing plot  

NA is always accepted regardless of the validation rule that has been set 

 

The camera button is used to take a photo linked to the current plot 

File names append the column and row number 
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If the current plot has a photo then the icon changes to a gallery icon 

Selecting this icon provides the option to take another picture or view the 

gallery 

Photos can be viewed and deleted from the gallery 

 

Comments can either be entered using the input box or pressing the comment 

button  

The comment button allows selection of previously entered comments 
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Return to the trait screen 

Select the Add Icon 

 

This is the full list of traits from Traits.csv 

Add a new trait by selecting it 

If the trait is not in the list then select New 
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Enter details for the trait 

String traits have a comma separated validation 

Select Save 

 

Note that the buttons change to match the validation rule 
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If there are too many options the 12th button provides an overflow

 

The Boolean data type provides TRUE and FALSE options 

 

Import Trial File is used to manually import data 
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Export Trials is used to write CSV files to the tablet. These files can be 

emailed or copied to a backup location 

 

View Online Help will open the online help page for Fieldscorer 

Check for updates checks for new versions of Fieldscorer and provides a 

download option if one exists 

Both options require internet access 

 

Exporting Data 

Exported Data is in a flat file CSV file format, with each plot representing one 

row in the file. Additional instances will occur with a double underscore 

(Height, Height__2, Height__3) and date stamping will occur with a Date_ 

prefix (Date_Height).  

 

To export data either select Save As from the file menu or Export Trials from 

the trial menu.  
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For a preview of the data to be exported, Preview Trial from the Trial Menu 

will generate an example of how the output should look.  

Exporting trials will overwrite the existing CSV files with whatever data is in 

the database for that trial. If using a folder with Internet synchronization of 

files, please ensure that care is taken if files are shared across multiple devices. 

Once a CSV file is exported it can be edited and re-imported back into the 

database. Importing a file into a database that already contains the trial file will 

overwrite all data for that trial. A backup file is created whenever this occurs 

before the data is overwritten.  
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